Using Excel 2000

Excel 2000 is one of the most popular spreadsheet software packages. It allows you to create electronic spreadsheets for many different applications, such as budgets, marketing and sales projections, accounting scenarios, etc. This document is intended to describe the basics of Excel 2000 required for typical spreadsheet development. For advanced features of Excel, you should consult an Excel manual or book, or check the HELP screens on topics of interest.

To start Excel2000, click on the START button on the task bar, select Programs, then Microsoft Excel. You will soon see the Excel application window as shown below:

When Excel starts, you are presented with a new, empty workbook called Book 1. A workbook is composed of sheets, or worksheets. The Excel worksheet window is the electronic spreadsheet work area. As you can see above, it is divided into cells, which are organized in rows and columns. Rows are identified by numbers (1, 2, 3, …), and columns are identified by letters (A, B, C, …). A cell is thus identified by a column letter and a row number. For example, the very first cell in the worksheet--the one that is "active" in the screen shot above--is cell A1 (column A, row 1). A cell reference (address) is always specified in the ColumnRow order. Note that the Name Box, shown above in the screen shot, displays the cell reference for the cell that is active. Anytime you wish to return to cell A1 in a spreadsheet, you may press the Ctrl+Home keys. (Hold the Ctrl key down and while holding it press the Home key).
As with other Office 2000 applications, commands are available in Excel by utilizing the various command bars. The Menu Bar contains all of the commands which are possible in Excel. The Status Bar explains the current command used and status of the system. The Standard Toolbar and Formatting Toolbar contain the most popular menu commands. As shown on the screenshot on the previous page, by default Excel 2000 has both the standard toolbar and the formatting toolbar share one row near the top of the screen. If you prefer to have these two toolbars on separate rows instead so that you can see all buttons at once, here is one way to change it:

1. Click on the Tools pull-down menu, then click on Customize:

2. From the next dialog box, click on the tab labeled Options, and uncheck the checkbox labeled Standard and Formatting toolbars share one row. After unchecking this box, click the Close button at the bottom and your toolbars will be on two rows rather than one.

Please check our other handout, What’s New in Office 2000? for additional information on using the toolbars and on Office 2000’s "personalized toolbars" and "personalized menus" feature. For clarity, most illustrations on this handout will show the toolbars in two rows rather than the default of one row.
Here is a listing of what each button does on the Standard and Formatting toolbars:

**Standard Toolbar**

- New workbook
- Print Preview
- Cut
- Paste
- Undo
- Insert
- Hyperlink
- Paste
- Function
- Sort
- Descending
- Display
- Drawing
- Toolbar
- Office
- Assistant
- (Help)
- Print
- Preview
- Save
- New
- workbook
- workbook
- Print
- Copy
- Redo
- Sort
- Ascending
- Chart
- Wizard
- Zoom

**Formatting Toolbar**

- Change
- Font
- Bold
- Underline
- Center
- cell
- contents
- Merge
- selected
- cells and
- center
- contents
- Apply
- percent
- style to
- selection
- Increase
- decimal
- (1.3 becomes
- 1.30)
- Decrease
- indent
- Add
- border
- Change
- font color
- in cell
- Font Size
- Italicize
- Left-align
- cell
- contents
- Right-align
- cell
- contents
- Apply currency
- style to
- selection
- Decrease
- decimal
- (1.30 becomes
- 1.3)
- Increase
- indent
- Change
- fill
- color
- (background
- color of cell)
The **Formula Bar** contains but two elements: the Name Box, where you can type a cell reference in directly in order to go to that cell, and the formula bar proper, which is where formulas you create will be displayed or typed:

Name box. Active cell reference is displayed here, or you can type in a cell reference to go to that cell.

Formula bar; where formulas are typed in or displayed after using built-in functions.

The appearance of the formula bar changes slightly once a formula is entered:

List of last functions used.

Cancel

Edit formula

Enter. *(Run formula)*

If for some reason you do *not* see these toolbars on your Excel screen, check your settings under the **View** pull-down menu, then click on **Toolbars:**

Be sure this box is checked to display the Formula Bar.
You may use the arrow keys, **PgUp**, **PgDn** keys as well as the **Home** key to move around to various cells in the spreadsheet. In addition, you may use the mouse to move to a cell, or type a cell reference directly into the Name Box. The mouse pointer in Excel is usually the block plus sign ( ▼). Your cursor may not necessarily be in the **active cell**, however, which is the cell with the heavy black border around it (called the cell selector). Anything you type while in Excel will be placed in the active cell. The **Esc** key may be used to cancel and exit many of the commands and functions.

To edit a cell's contents—whether it contains numbers or text—you may once click directly in the cell and then edit its contents within the Formula Bar. The Formula Bar will always display the contents of the active cell. You may also press the **F2** key (the Edit key) which will place an insertion point within the cell itself so that you may change its contents. Double-clicking within a cell has the same effect.

Want to change a cell's contents completely—and just start from scratch? **Right-click** in the cell, and from the next menu, left-click on the choice to **Clear Contents**. This will erase the contents of the cell (numbers, text, etc.), but not any formatting (borders, background color, etc.).

If you want to get rid of the contents as well as all formatting, select the cell and go to the **Edit** pull-down menu, click **Clear**, then click **All** from the following menu. The cell will go back to being completely blank.
SAVING YOUR WORK

To save an Excel spreadsheet, click on the File pull-down menu, then Save or (particularly if you want to re-name your spreadsheet without changing the contents of the one you originally opened) Save As. The following dialog box appears:

To continue saving to the same drive afterwards, just click on the Save button ( ) located on the Standard Toolbar. Note: Do not switch floppy disks if you have already saved to your A: (floppy) drive once. If you change to a different floppy disk as a backup, you will get an error message!

CELL VALUES - TEXT

When you type any character--as opposed to a number--into a cell, the value is considered a text type. Text values are generally used to specify titles on the worksheet--column titles, row titles, or the general spreadsheet title. After entering the text, either press the Enter key on your keyboard or click the Enter button ( ) on the Formula Bar. (The Enter button appears on the Formula Bar as soon as you begin typing something in the cell.) While typing the text value, if you make a mistake, use the Delete key or the Backspace key to correct your typing errors.

Note that text values are, by default, left-justified in a cell--much like text would be in a word processor. If the text value you type in exceeds the cell width on the screen, it is still stored as all of the characters typed, even though not all of it may be displayed in the spreadsheet. In fact, if the adjacent cell(s) has a data value, the text will not be displayed as "spilling over" into
the cell, but rather just appear cut off. On the other hand, if the adjacent cell(s) has no value, then the text will be displayed in its entirety.

To illustrate, here are some screen shots showing a cell with text value when *first* entered, and then how the text value is shown on the screen one a value is place in the cell next to it. First, here is some text typed in cell A2:

Next, we move the active cell to cell B2 by either pressing the Tab key on the keyboard or by using the mouse and clicking in the cell. Note that you can still see the text from A2 "spill over" into cell B2, but notice the Formula Bar is now blank. This is a clear indication--apart from the Name Box displaying B2--that you are in a different cell:

Now, if you start typing any value in cell B2, cell A2 appears "cut off." That's okay, though, because the complete contents are still intact. (We'll see later how to adjust the cell width so that you can see all of the contents on the screen.)
CELL WIDTH

By default, the width of each cell in Excel is approximately 9 characters (8.43, to be exact). This is true for each column of cells in Excel. To change this width, point your mouse at the border of the column in the very top row where the column labels (A B C D ....) are located, wait for the mouse pointer to turn into a double-sided arrow (       ) and drag the border left or right. There is also an autofit feature, where double-clicking on the column border will automatically change the column width to the width of the largest cell in that column:

Alternatively, you can click on the Format pull-down menu, then Column, and finally Width, and type a value in the dialog box that results:

These pull-down menus on the left result in the dialog box below. Type a width value (as measured by number of characters in the default Arial 10-point font size) in the box.
CELL VALUES - NUMBERS

By default, numbers are right justified in cells when entered. To specify a negative number, precede the number with the minus (-) sign or enclose it in parentheses. For example, negative ten may be specified as -10 or (10).

CELL VALUES - FORMULAS

The primary reason for the popularity of electronic spreadsheets is that cells may contain formulas as their contents. For example, you may wish to have cell B5 display the sum of cells B3 and B4. Rather than add the two cell values manually (which defeats the purpose of having a spreadsheet to begin with!), you would specify a formula in cell B5 that would look like:

=B3+B4

Notice that this formula indicates that cell B3's contents should be added to cell B4's contents. Also, note that cell B3 in the formula is preceded by an equals sign (=). The equals sign is necessary to let Excel "know" that this is a formula. If the equals sign were not included, Excel would treat B3+B4 as though it were regular text. You must precede formulas with an equals sign (=) in Excel (the plus sign (+) or minus sign (-) works, too), even when the first entry is a digit or parentheses.

The table below displays the arithmetic operators you may use in Excel together with their relative precedence. (Precedence refers to the order in which operations will be evaluated in an arithmetic expression.)

<table>
<thead>
<tr>
<th>Operator Symbol</th>
<th>Operator Meaning</th>
<th>Precedence</th>
</tr>
</thead>
<tbody>
<tr>
<td>()</td>
<td>Parentheses</td>
<td>1 (anything within parentheses takes precedence)</td>
</tr>
<tr>
<td>–</td>
<td>Negation</td>
<td>2</td>
</tr>
<tr>
<td>%</td>
<td>Percent</td>
<td>3</td>
</tr>
<tr>
<td>^</td>
<td>Exponentiation</td>
<td>4</td>
</tr>
<tr>
<td>* , /</td>
<td>Multiplication and Division</td>
<td>5</td>
</tr>
<tr>
<td>+ , –</td>
<td>Addition and Subtraction</td>
<td>6</td>
</tr>
</tbody>
</table>

Following this table, the formula =C2+C3*B3 will be evaluated as "C3 multiplied by B3, with this product added to C2." If this is not what was intended, then the first two elements should be placed in parentheses, such as this: =(C2+C3)*B3. Items within parentheses are always processed first, so in this case the formula would be evaluated as "C2 plus C3, with this sum multiplied by B3."
ENTERING FORMULAS

Typing in Formulas

Excel offers several ways of entering formulas. The most direct is simply typing in the entire formula on the Formula Bar. For example, if you want to divide the contents of cell C4 by the contents of cell B4, first make sure that your active cell is where you want the formula results to appear, then type the following into the Formula Bar: =c4/b4 (Capital letters are not necessary in formulas when entering cell references.) After entering the formula, either press the Enter key or click the green checkmark Enter button in the Formula Bar, and the result of the formula should appear in the active cell:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Used Car Sales for April</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Number Sold</td>
<td>Total Dollar Sales</td>
<td>Avg. Per Car</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>12</td>
<td>72516</td>
<td>6043</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Notice on the Formula Bar that when cell D4 is active, that the result of the formula does not appear, but rather the formula itself. When you are busy editing a spreadsheet, it is sometimes difficult to remember which cells contain numbers you typed in as opposed to which cells contain the result of a formula. A good indicator is to keep your eye on the Formula Bar. Numbers merely typed in will appear just as numbers, while numbers that are the result of a formula will appear as the formula.

Selecting Cell References

Another way to enter a formula is by selecting cell references with the mouse rather than typing them in manually. Many find this easier since you just click in the cell you want as part of the formula rather than trying to figure out the cell reference on your own.

To use this method, again have your cursor in the cell where you want the results to appear. Let's say you want to multiply cell B7 by cell C7, with the result appearing in cell D7. Position your cursor in cell D7. Then, in the Formula Bar, type in the equals sign to indicate a formula. Next, move your cursor to cell B7 and simply left-click the mouse. You should see B7 now in the Formula Bar. Next, type in the asterisk symbol (*) to indicate you want to multiply, then left-click in cell C7 to complete your formula. To finish, just click the green checkmark Enter button in the Formula Bar or press the Enter key on the keyboard, and you're done, with the product appearing in D7.
Using Excel 2000

Using the Formula Palette

Though usually used when entering functions (explained later), you may also want to use the formula palette for entering formulas. The formula palette uses either of the methods described above (typing the cell references by hand or clicking within the cell), but best of all inputs the equals sign for you (an easy thing to forget to do!) and even displays what the result will be before you click the green checkmark Enter button.

To get the formula palette, once your cursor is in the cell where you want the results to appear, click on the equals sign button that appears on the Formula Bar (the Edit Formula button), and the palette will open:

Formula Palette. (Note the beginning equals sign is automatically entered on the Formula Bar.) If the Formula Palette is in your way, you can click and drag it out of the way by left-clicking in any gray area that does not have a button.

At this point, you can either point to the cells you want in your formula or type the cell references in. Let's say you want to subtract cells B4 and C4 from A4. Here is what the palette will look like just after typing in the cell references:

Notice that the Formula result appears in the palette, even before you click the Enter button. This enables you to change formulas "on the fly" while creating them.

Changing Existing Formulas

To change a formula you've already input, simply go to the cell containing the formula result, and edit the formula that's in the Formula Bar using any of the methods discussed.
ENTERING BUILT-IN FUNCTIONS - SUM

There are several functions built into Excel to support common mathematical expressions. For example, it is often desirable to sum an entire row or column of values. Let's say that we wish to specify cell D17's contents to be:

= D2 + D3 + D4 + D5 + D6 + D7 + D8 + D9 + D10 + D11 + D12 + D13 + D14 + D15 + D16

Even with the "point and click" method of selecting cell references in a formula, that's a lot to type into the Formula Bar! Excel therefore provides a built-in function called SUM to facilitate this. So, instead of the above formula, you can instead type in cell D17:

= SUM(D2:D16)  

[The colon is used to express an inclusive range of cells.]

Alternatively, you can use your mouse to select the cells by first typing into the Formula Bar:

= SUM(D2:D16)

then moving the mouse to cell D2, then click and drag the mouse to cell D16, and then complete the formula by typing the closing ) at the end of the formula.

The AutoSum Button

An easier way to quickly sum a range of cells is to click the AutoSum button (Σ) on the Standard Toolbar. This saves you the trouble of manually doing the SUM function as outlined above. Excel will often try to "guess" what range of cells you are trying to sum after clicking the AutoSum button by showing the range in a "scrolling marquee." If Excel "guesses" correctly, you need only click the AutoSum button again or just press the Enter key on your keyboard. If Excel "guesses" incorrectly, simply click and drag your mouse over the cells you want summed and click the AutoSum button again:

<table>
<thead>
<tr>
<th>IF</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Car Sales for the Quarter</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>June</td>
<td>July</td>
<td>August</td>
<td>Total Sales</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Carolyn</td>
<td>9</td>
<td>10</td>
<td>=SUM(B3:D3)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Cynthia</td>
<td>13</td>
<td>12</td>
<td>18</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Frank</td>
<td>13</td>
<td>9</td>
<td>15</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Joe</td>
<td>10</td>
<td>7</td>
<td>13</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Sally</td>
<td>14</td>
<td>8</td>
<td>20</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Sam</td>
<td>9</td>
<td>11</td>
<td>12</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Totals</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Clicking the AutoSum button while cell E3 is the active cell brings up a "scrolling marquee" around the cells that Excel assumes you want to sum. Since Excel is "guessing" correctly, just click the AutoSum button again to complete the operation. If you wanted a different range summed, you would click and drag around the cells you wanted Excel to sum with the mouse, then click AutoSum again.
ENTERING BUILT-IN FUNCTIONS USING THE PASTE FUNCTION BUTTON

The easiest way to enter functions in Excel is by clicking the Paste Function button on the Standard Toolbar. Doing this opens up the Paste Function dialog box, which allows you to select the function you want Excel to use. You can click once on any of the function categories listed on the left to see the various functions names in that category on the right, or click on All on the left to see all of the over 250 functions Excel has:

For example, say you would like to do an average of numbers in a column. After clicking the Paste Function button, click once on the Statistical function category, then double-click on Average on the right. This will bring up a formula palette box that will guide you through how to construct your formula containing the function. You may move this formula palette box anywhere on your screen by clicking and dragging within it. By default, Excel will try to "guess" which cell references to include in your formula:

Required boxes to fill in for a function are in bold face type.

Excel "guesses" a cell range for your function. You can change these cell references by typing them in yourself, or... by clicking this icon, the function palette "collapses" and gives you room to click and drag over the cells you want.

Returns the average (arithmetic mean) of its arguments, which can be numbers or names, arrays, or references that contain numbers.

- **Number1**: number1, number2, ... are 1 to 30 numeric arguments for which you want the average.

Formula result = 14.5

= 14.5

Dominican University  Using Excel 2000
Rather than inputting cell references yourself, it is easier to click on the "collapse dialog box" icon on the far right of where you would input the cell references to include. This moves the formula palette out of the way and allows you to left-click and drag over the cells you want to include:

![Formula Palette](image)

Click and drag with your mouse over the cells you want in your function. Notice the function name and full formula appears in the Formula Bar.

After clicking and dragging over the cells for your function, either press the Enter key on the keyboard or click the "restore dialog box" icon. This will bring you back to the formula palette box, where you can now click OK. If all went well, the cell containing the results of your function should have a formula like: \[=\text{AVERAGE}(B3:D8)\]

Using the Paste Function button is a great way to learn all of Excel's built-in functions. Plus, it aids you in constructing the proper way the function should look with the help of the formula palette.

**THE IF FUNCTION**

Another handy function to know about is the IF function. This is used to decide which of two (or more) different values should be displayed in a cell. The syntax of the IF function is:

\[=\text{IF}(\text{logical-test}, \text{value-if-true}, \text{value-if-false})\]

For example, the formula \[=\text{IF}(C7>=70, \text{"PASS"}, \text{"FAIL"})\] will display the text value "PASS" in the active cell if the value in cell C7 is greater than or equal to 70, and will display the text value "FAIL" otherwise.

If this looks a bit confusing, don't worry, since like all functions you may find it easier to use the IF function by clicking on the Paste Function button on the Standard Toolbar, then going to the Logical function category and selecting IF. After clicking OK, you will see the following formula palette:
Let's say that our used car sales lot has a quarterly quota of 30 cars that should be sold by each salesperson. We can label a column called "Met Quarterly Sales Quota?" next to the quarterly sales totals for each salesperson. Then, we can use the IF function to indicate with a **YES** or a **NO** if the salesperson met that quota. In the above dialog box, we can either type in the cells we wish to reference using the IF function or use the "collapse dialog box" icon (   ) to click and drag over the cells for the formula. Here is what our spreadsheet looks like, with the Formula Palette displayed as well as the what the resulting formula looks like on the Formula Bar:

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Car Sales for the Quarter</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Carolyn</td>
<td>June</td>
<td>July</td>
<td>August</td>
<td>Total Sales</td>
</tr>
<tr>
<td>3</td>
<td>9</td>
<td>10</td>
<td>9</td>
<td>28</td>
<td>IF($E3&gt;=30,&quot;YES&quot;,&quot;NO&quot;)</td>
</tr>
<tr>
<td>4</td>
<td>Cynthia</td>
<td>13</td>
<td>12</td>
<td>18</td>
<td>43</td>
</tr>
<tr>
<td>5</td>
<td>13</td>
<td>9</td>
<td>15</td>
<td>37</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Joe</td>
<td>10</td>
<td>7</td>
<td>13</td>
<td>30</td>
</tr>
<tr>
<td>7</td>
<td>Sally</td>
<td>14</td>
<td>8</td>
<td>20</td>
<td>42</td>
</tr>
<tr>
<td>8</td>
<td>Sam</td>
<td>9</td>
<td>11</td>
<td>12</td>
<td>32</td>
</tr>
</tbody>
</table>

Excel adds quotation marks around terms automatically; there is no need to type them in manually.
In the above example, we want cell F3 (the active cell) to display the word YES if the salesperson reached her quota of 30 cars or above (the "Value_if_true" part of the function), or NO if she didn't (the "Value_if_false" part of the function). For the logical test, you may use the standard mathematical relational operators:

<table>
<thead>
<tr>
<th>&gt; greater than</th>
<th>&lt; less than</th>
<th>= equal to</th>
<th>&lt;&gt; not equal to</th>
<th>&gt;= greater than or equal to</th>
<th>&lt;= less than or equal to</th>
</tr>
</thead>
</table>

After clicking OK in the IF function dialog box, here is the result:

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Car Sales for the Quarter</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>June</td>
<td>July</td>
<td>Total Sales</td>
<td>Met Quota of 30 Sales?</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Carolyn</td>
<td>9</td>
<td>10</td>
<td>9</td>
<td>28</td>
<td>NO</td>
</tr>
<tr>
<td>4</td>
<td>Cynthia</td>
<td>13</td>
<td>12</td>
<td>18</td>
<td>43</td>
<td></td>
</tr>
</tbody>
</table>

For information on another function often used, the VLOOKUP function, consult our separate handout *The VLOOKUP Function in Excel 2000*.

**COPYING FORMULAS**

Once you have entered a formula or function into a cell, you may want to copy it down a column or across a row. This is very easy to do:

- First, place the cursor in a cell that contains the formula you want to copy and make it the active cell by clicking in it.
- Next, move your cursor down to the lower right-hand corner of the active cell, where you will see a small square (called the fill handle). If done properly, your cursor will change from the large, white plus sign cursor to a small, black plus sign: ✈️
- Next, click and drag the fill handle through all the cells you want to copy the formula to. Release the mouse button when finished. If done properly, you will now see the formula results in all the cells.

Below is a screen shot showing copying formulas with the fill handle:
When formulas are copied this way, **relative cell addresses** in the formulas will be updated accordingly. In the above example, this means when the formula is copied, the part of the formula that contains E3 will automatically change as it's copied down to E4, then to E5, E6, and so on. **Absolute cell addresses**—discussed later—will **not** be copied down when formulas are copied!

**COPYING CELL CONTENTS**

You can copy cell contents with the traditional **Copy** and **Paste** method used with any other Windows application:

- Select a cell or range of cells by clicking and dragging.
- Click on the COPY button on the Standard Toolbar:
- Select the cell(s) you want the content copied to, then click the PASTE button:

When copying cells this way, you will notice the original cells will still have a "scrolling marquee" around them. This means you can continue pasting those cell contents elsewhere. To get rid of the scrolling marquee, simply press the **Esc** button on your keyboard or start typing in another cell.

**MOVING CELL CONTENTS**

You may move cell contents with the traditional **Cut** and **Paste** method used with any other Windows application:

- Select a cell or range of cells by clicking and dragging.
- Click on the CUT button on the Standard Toolbar:
- Select the cell(s) you want the content moved to, then click the PASTE button:

A quicker way to move cell contents—particularly when you don't have far to move them—is using the mouse. First, select the cell or range of cells you want to move by clicking and dragging. Then, move the mouse just outside the selected area until you see the mouse cursor change into an arrow shape. Once it does, click and drag the selection to the area you want to move it to, then release the mouse button. Below is a screen shot of what the cursor should look when moving cells by clicking and dragging this way:

---

Dominican University

**Using Excel 2000**
INSERTING AND DELETING ROWS AND COLUMNS

To insert a row into your spreadsheet:

• Place your cursor in the row below where you want the new row inserted.
• Click on the Insert pull-down menu in the menu bar, then click Rows.
• A row will be inserted just above your cursor, and any formulas containing relative cell addresses will remain intact.

To insert a column into your spreadsheet:

• Place your cursor in the column to the right of where you want the column inserted.
• Click on the Insert pull-down menu in the menu bar, then click Columns.
• A column will be inserted to the right of your cursor, and any formulas containing relative cell addresses will remain intact.

To delete a row or column in your spreadsheet:

• Place your cursor in the column or row to be deleted.
• Click on the Edit pull-down menu in the menu bar, then click Delete.
• From the following dialog box, select either Entire Row or Entire Column:

As is the case with inserting columns or rows, formulas will be updated accordingly.
ABSOLUTE VS. RELATIVE CELL ADDRESSING

By default, cell references in *Excel* are relative references. This means that when a formula is copied, cell references are adjusted accordingly, namely by changing the row number or column letter in the affected formulas. For example, notice cell B10 below contains the formula =SUM(B4:B9) as shown below:

If we copy the formula over to the right into cell C10 using the copy commands with the mouse discussed earlier, notice the cell references in the formula are adjusted one column to the right, too:

While this is a good feature to keep from re-typing in formulas, sometimes this is *not* desirable! Sometimes, when a formula is copied, you do not want a cell reference to be adjusted, but want it to remain exactly as it is. In this case, we must "fix" the address in the formula so that it will remain the same. When an address is "fixed" in this way, it is called an *absolute* cell reference. To change an address to an absolute cell reference, you should place a dollar sign character immediately before both the column and row references. For example, to ensure that cell E4 never changes when it is part of a formula, you would type in $E$4.
Here is an example. In the spreadsheet below, we want the final column on the right (column F) to reflect the percentage of sales that the salesperson was responsible for within the entire quarter:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F%</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Car Sales for the Quarter</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>June</td>
<td>July</td>
<td>August</td>
<td>Total Sales</td>
<td>% of Total Quarterly Sales</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Carolyn</td>
<td>9</td>
<td>10</td>
<td>9</td>
<td>28</td>
<td>13%</td>
</tr>
<tr>
<td>5</td>
<td>Cynthia</td>
<td>13</td>
<td>12</td>
<td>18</td>
<td>43</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Frank</td>
<td>13</td>
<td>9</td>
<td>15</td>
<td>37</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Joe</td>
<td>10</td>
<td>7</td>
<td>13</td>
<td>30</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Sally</td>
<td>14</td>
<td>8</td>
<td>20</td>
<td>42</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Sam</td>
<td>9</td>
<td>11</td>
<td>12</td>
<td>32</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Totals</td>
<td>68</td>
<td>57</td>
<td>87</td>
<td>212</td>
<td></td>
</tr>
</tbody>
</table>

To find the percentage, we divide the total sales for all salespeople for the quarter (cell E11) by the salesperson's total sales for the quarter (cell E4). So far, so good. (We also have to click the Percent Style button on the formatting toolbar to show percentage-style figures.) But if we try copying the formula down the column for each salesperson, a series of error messages come up:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F%</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Car Sales for the Quarter</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>June</td>
<td>July</td>
<td>August</td>
<td>Total Sales</td>
<td>% of Total Quarterly Sales</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Carolyn</td>
<td>9</td>
<td>10</td>
<td>9</td>
<td>28</td>
<td>13%</td>
</tr>
<tr>
<td>5</td>
<td>Cynthia</td>
<td>13</td>
<td>12</td>
<td>18</td>
<td>43</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Frank</td>
<td>13</td>
<td>9</td>
<td>15</td>
<td>37</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Joe</td>
<td>10</td>
<td>7</td>
<td>13</td>
<td>30</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Sally</td>
<td>14</td>
<td>8</td>
<td>20</td>
<td>42</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Sam</td>
<td>9</td>
<td>11</td>
<td>12</td>
<td>32</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Totals</td>
<td>68</td>
<td>57</td>
<td>87</td>
<td>212</td>
<td></td>
</tr>
</tbody>
</table>

Here is what happened. As you can see in cell F5, when we copied the formula down column F, Excel "assumed" (as it does by default), that we wanted the formula to copy down and adjust accordingly, too. So, instead of our original formula of =E4/E11, when we copied it Excel made the next formula down =E5/E12, and the next one after that =E6/E13, and so on. The #DIV/0! messages are generated because Excel thinks you are trying to divide something by zero--since there is nothing in cells E12, cell E13, etc.

So to solve this problem, we should change our original formula in cell F4 to the following: =E4/E$11. By placing the $ before both the column letter and the row number, we are instructing Excel that if the formula gets copied, it can make the necessary "adjustment" to the numerator, but that the denominator (E11) must remain absolute, since we will always want the formula to check our Total Sales figure in that cell.
Here is what the revised formula now looks like in cell F4:

The answer in cell F4 remains the same, but now note the difference when we copy the formula down column F, thanks to the addition of the absolute cell reference in the formula:

With the absolute reference, when we copy the formula down, the denominator always refers to cell E11, but the numerator correctly "adjusts" itself.

TIP: To edit an existing formula to change part of it to an absolute reference, put your cursor in the formula bar anywhere in the part of the formula you want to change, and press the F4 function key on the keyboard. It will change to an absolute reference:

Insertion point is placed in the part of the formula you want to change to an absolute reference . . .

... after pressing the F4 function key on keyboard, cell reference is changed to an absolute reference.
If you want to change the appearance of numbers or text in your spreadsheet, you can use buttons in the Formatting Toolbar or use various commands in the **Format** pull-down menu. Much of the time, you'll find the commands you want are readily accessible in the Formatting Toolbar.

**Font Type**

Font type defines the appearance and shape of letters, numbers, and other characters. The default font type in *Excel* is typically set at the Arial font type, such as that shown here. You may, however, want to change this to font types such as Times New Roman (the font used in most of this document), or other types. To specify to particular font type for cell values, do the following:

- Select the cell or cells to which the new font type will be applied.
- Click the down arrow in the font type area of the Formatting Toolbar
- Click the font type desired.

![Font Type screenshot](image)

**Font Size**

Font size specifies the size of the characters in the cells. The default font size is 10 in *Excel*. Font size is measured in **points**, which is approximately 1/72 of an inch. To change the font size of the values in cells, do the following:

- Select the cell or cells to which the new font size will be applied.
- Click the down arrow in the font size area of the Formatting Toolbar (just to the right of the font type area--see above screen shot).
- Click the font size desired.
**Bold, Italicize, and Underline**

You can also make cell values appear in **bold face type**, in *italics*, or underlined. The procedure is the same for any of these:

- Select the cell or cells that you want to bold, italicize, or underline.
- Click on the appropriate button in the Formatting Toolbar:

<table>
<thead>
<tr>
<th></th>
<th></th>
<th>Bold button</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td></td>
<td><strong>Bold</strong></td>
</tr>
<tr>
<td>I</td>
<td></td>
<td><em>Italics</em></td>
</tr>
<tr>
<td>U</td>
<td></td>
<td><strong>Underline</strong></td>
</tr>
</tbody>
</table>

Note that **underlining** cell values is not the same as drawing a line across a row, discussed later. Selecting cells and underlining them will *not* underline across all the cells, but rather underline the specific values within the cells. For example, in the below screen shot, the contents of row 3 were first selected with the mouse, then underlined:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Car Sales for the Quarter</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>June</td>
<td>July</td>
<td>August</td>
<td><strong>Total Sales</strong></td>
<td>% of Total Quarterly Sales</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Carolyn</td>
<td>9</td>
<td>10</td>
<td>9</td>
<td>28</td>
<td>13%</td>
</tr>
</tbody>
</table>

Note the difference when, instead, the contents of row 3 were first selected with a mouse, then had a line drawn under them:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Car Sales for the Quarter</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>June</td>
<td>July</td>
<td>August</td>
<td><strong>Total Sales</strong></td>
<td>% of Total Quarterly Sales</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Carolyn</td>
<td>9</td>
<td>10</td>
<td>9</td>
<td>28</td>
<td>13%</td>
</tr>
</tbody>
</table>

Again, the technique used to draw a line rather than underline will be discussed below.
**Aligning Cell Values**

You can left-align, right-align, or center cell values. Remember that, by default, numeric values are right-aligned in Excel, while text values are left-aligned. To force a different alignment, do the following:

- Select the cell or cells that you want to change the alignment for.
- Click on the appropriate button in the Formatting Toolbar:

  | [Left-align button](#) |
  | [Center-align button](#) |
  | [Right-align button](#) |

**Centering Text Across a Block of Cells**

Centering text across a block of cells is a good way of centering the title of your spreadsheet across several columns. Remember, when you type a lengthy block of text into one cell (for example, cell A1), the text value is associated with just that one cell—even if the text "flows" over into other cells. Clicking the center-align button, as mentioned above, will succeed only in forcing Excel to center everything within that one cell! Instead, you should do the following:

- Select the cells across which you'd like your text to be centered. Remember to include the text value from the first cell of this block!
- Click the **Merge and Center** button on the Formatting Toolbar:

Text in cell A1 before doing a Merge and Center:

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Car Sales for the Quarter</td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Car Sales for the Quarter</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>June</td>
<td>July</td>
<td>August</td>
<td>Total Sales</td>
<td>% of Total Quarterly Sales</td>
</tr>
<tr>
<td>4</td>
<td>Carolyn</td>
<td>9</td>
<td>10</td>
<td>9</td>
<td>28</td>
</tr>
</tbody>
</table>

Text in cell A1 after selecting cells A1 through F1 and clicking the Merge and Center button. Notice that entire length is still called A1 in the name box.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Car Sales for the Quarter</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>June</td>
<td>July</td>
<td>August</td>
<td>Total Sales</td>
<td>% of Total Quarterly Sales</td>
</tr>
<tr>
<td>4</td>
<td>Carolyn</td>
<td>9</td>
<td>10</td>
<td>9</td>
<td>28</td>
</tr>
</tbody>
</table>

Dominican University Using Excel 2000
**Line Drawing**

It is also often desirable to draw solid lines in a spreadsheet, either to offset some cells from others, or to box-enclose cells. There are a couple of ways to do this. If you just want lines around the outside of cells, you may do the following:

- Select the cell or cells for which line borders are to be drawn.
- Click the down-arrow icon just to the right of the **Borders** button on the Formatting Toolbar.
- Click the border style you want:

For fancier borders with more selection of line types, do the following:

- Select the cell or cells for which line borders are to be drawn.
- Click the **Format** pull-down menu, then click **Cells**.
- From the following dialog box, make sure the **Border** tab is selected, and select the borders you want, and where you want them:
Here is a screen shot from our spreadsheet after applying the type of borders shown above to the Totals section:

<table>
<thead>
<tr>
<th></th>
<th>Joe</th>
<th>10</th>
<th>7</th>
<th>13</th>
<th>30</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Sally</td>
<td>14</td>
<td>8</td>
<td>20</td>
<td>42</td>
</tr>
<tr>
<td>9</td>
<td>Sam</td>
<td>9</td>
<td>11</td>
<td>12</td>
<td>32</td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Totals</td>
<td>68</td>
<td>57</td>
<td>87</td>
<td>212</td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

As an example of several of the features mentioned above, here is the top of a spreadsheet, with a fairly lengthy text value in cell A1 that was done in the default Arial font in 10 point font size, left-justified in cell A1. The other cells have the default alignment with no borders.

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Here is the same spreadsheet after changing the contents of A1 to Book Antigua font, 16-point font size, and making it bold face. Next, we selected cells A1 through F1, and clicked the **Merge and Center** button from the Formatting Toolbar. We bolded **Totals** at the bottom and added borders around each total. We centered the **% of Total Quarterly Sales** column, and drew a line under the entire contents of row 3. We also drew vertical lines around the columns:

<p>| | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Dominican University  
Using Excel 2000
FORMATTING CELL DISPLAY VALUES - NUMERIC VALUES

In some of our previous screenshots, you saw a column of numbers expressed as percentages. This is not done automatically in Excel, but is rather done by changing the numbering style in cells. Generally, it is considered easier to add special characters such as dollar signs ($), commas in numbers (,), or percentage signs (%) after doing all of your calculations and formulas.

The easiest way to add certain numeric styles to cells containing numeric values is as follows:

- Select the cell or cells containing the numeric values to be formatted
- Click the appropriate button on the Formatting Toolbar. Here are the buttons, and what numbers on your Excel spreadsheet look like before and after applying the number style:

<table>
<thead>
<tr>
<th>Formatting Toolbar Button</th>
<th>What the Button Does</th>
<th>Example of a Number Before the Style is Added</th>
<th>Example of a Number After the Style is Added</th>
</tr>
</thead>
<tbody>
<tr>
<td>$</td>
<td>Currency Style</td>
<td>150</td>
<td>$150.00 [Decimal places added by default]</td>
</tr>
<tr>
<td>%</td>
<td>Percentage Style</td>
<td>0.25</td>
<td>25% [Original number should generally be between .01 and 1.0!]</td>
</tr>
<tr>
<td>,</td>
<td>Comma Style</td>
<td>38293</td>
<td>38,293.00 [Decimal places added by default]</td>
</tr>
</tbody>
</table>

In addition to the above, you can increase decimal places or decrease decimal places by clicking on the following buttons in the Formatting Toolbar--and can continue clicking the button multiple times to increase/decrease the appropriate number of times:

<table>
<thead>
<tr>
<th>Formatting Toolbar Button</th>
<th>What the Button Does</th>
<th>Original Number</th>
<th>Example of a Number When Button is Clicked Once</th>
<th>Example of a Number When the Button is Clicked Twice</th>
</tr>
</thead>
<tbody>
<tr>
<td>+.00</td>
<td>Increase decimal</td>
<td>25.256</td>
<td>25.2560</td>
<td>225.25600</td>
</tr>
<tr>
<td>-.00</td>
<td>Decrease decimal</td>
<td>400.7569</td>
<td>400.757</td>
<td>400.76</td>
</tr>
</tbody>
</table>
FORMAT CELLS DIALOG BOX

Virtually all of the commands discussed above using various buttons from the Formatting Toolbar (borders, numeric values, etc.) are collected in one dialog box by clicking on the Format pull-down menu, then Cells. This menu is also accessible by right-clicking anywhere within selected cells, and then left-clicking Format Cells. Click on the tab related to what you want to change within the selected cells:

For specific help about any menu choice within a dialog box, remember to click on the question mark icon. Your mouse cursor will then have a question mark "attached" to it. You can then click on the part of the dialog box you don't understand for context-sensitive help.

CHARTS - GRAPHING YOUR DATA

Excel provides a way to add a chart to your workbook. You may add the chart as either an embedded chart within your workbook so that it appears within the same sheet as your data, or as a separate chart sheet. Other options include selecting a two-dimensional chart type or a three-dimensional chart type, selecting a column chart, line chart, or pie chart, and numerous other possibilities. Always remember to tailor the type of chart you select to the type of data you are showing. Generally, a column chart is used to show trends and comparisons, with each column representing a magnitude of the value it represents. A pie chart, on the other hand, is used to show how 100% of an amount is divided. Each slide (or wedge) of the pie represents a contribution to the whole.
Creating Charts

To create a chart, it's generally easiest to select the cells you want to chart first, including the labels on the rows/columns, which will be converted to axis label information and the text that appears in the legend for the chart. Virtually anything can be changed while creating the chart, and virtually anything can be changed after the chart is created, but the more that can be done while creating it, the better.

After selecting the cells you wish to chart, here are the steps to take:

1) Click Insert on the pull-down menu, then Chart, or click the Chart Wizard button ( ) on the Standard Toolbar.
2) The Chart Wizard will walk you through the four steps involved in creating a chart. If at any time you need to go back to a previous step, click the Back button.

a) In Step 1, select the chart type. Click on the desired type, then select the chart subtype:

Select from various chart subtypes here, after first selecting a chart type on the left. In this case, a clustered column with 3-D visual effect has been selected.

After selecting a chart type, click this button for a "sneak preview" of what your chart will look like. You may want to change your mind after looking at it!

Click Next to continue.
b) In Step 2, you are asked to verify the cell range. You can enter a different range in the box provided, or use the collapse dialog box to select with your mouse a different range:

If things look really bad, you can click on the collapse dialog box icon here, and re-select a cell range with your mouse in the Excel spreadsheet, then click the restore dialog box again to come back here.

Excel usually correctly "guesses" how you want your data presented, but to check out a different format, click the other button to see how it looks. You can always click the original one again!

c) Step 3 will display a sample of the chart type and format, as well as (depending on the type of chart you've selected) several tabs with additional labeling options:

Be sure to take a look at each tab to see other options available. Don't forget to click the question mark button for help on each feature. Also, keep an eye on the preview!
d) Step 4 will ask you for the chart location. Here is where you can select to have your chart as a new sheet (called Chart 1) as part of your workbook, or to have it as an object within the current sheet:

![Chart Wizard - Step 4 of 4 - Chart Location](chart_wizard.png)

e) After clicking the Finish button, the chart will appear. If in your current worksheet, you will likely have to drag it with the mouse to a new location. It may also appear to be rather small. A chart is like any other object—you can click on the object and click and drag the resizing handles to make it bigger.

**Editing an Existing Chart**

To change the appearance of something in your chart—such as the color or font size—double-click the item in question to get a dialog box of various choices. Another option is to right-click anywhere within the chart to get a menu of choices to change the source data, chart type, chart options, and other choices. In addition, the **Chart Toolbar** should appear whenever you create a chart. (If it doesn't, click the **View** pull-down menu, then **Toolbars**, and click **Chart**.) Using this toolbar, you can select a specific part of the chart, and then click the **Format** button on the chart toolbar to make color or font changes:

![Chart Toolbar](chart_toolbar.png)

Clicking the **Format** button after selecting a part of the chart to edit will bring up a dialog box to enable various changes.
Data Changes? No Problem!

Once you have created a chart, you need not worry if the data in your workbook changes. All changes to the original data will be reflected in your chart!

SPELL-CHECKING

To spell-check your worksheet, click on the Spelling button on the Standard Toolbar, or click the Tools pull-down menu, then Spelling. Excel has a spell-checker that will bring to your attention any words it encounters that do not appear in its dictionaries, much like a word processor's spell-checker will. The Spelling dialog box will appear for any word in the spreadsheet that does not match a word in the dictionary. Click the Change button to accept Excel's recommendation for the correct spelling, or the Ignore button if you want the word to remain as it appears.

GETTINGREADY FOR PRINTING

Always save your spreadsheet (as described at the beginning of this document) before printing it, since many problems can occur when printing a spreadsheet. To get an idea of what your spreadsheet will look like before printing it, it's a good idea to use the Print Preview feature, available by clicking the File pull-down menu, then clicking on Print Preview, or by clicking on the Print Preview button on the Standard Toolbar:

Page Setup

There are many options available for formatting the appearance of your spreadsheet before printing by clicking on the File pull-down menu, then Page Setup. As with many dialog boxes in Excel, it will be of benefit to examine the various choices available under each tab. Here are the choices on the Page tab of the Page Setup box:

Since many spreadsheets don't fit onto a portrait-oriented sheet of paper, you may want to click the Landscape button here.

Always preview what you've done!

Spreadsheet just a little bit too big to fit onto one sheet of paper? Try changing the Adjust to percentage here, or click the Fit to: button. Careful, though--the print size will be affected!
Another tab you should click is the **Sheet** tab:

![Page Setup dialog box](image)

<table>
<thead>
<tr>
<th>Print area:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Print titles:</td>
<td></td>
</tr>
<tr>
<td>Rows to repeat at top:</td>
<td></td>
</tr>
<tr>
<td>Columns to repeat at left:</td>
<td></td>
</tr>
</tbody>
</table>

- **Gridlines**
- **Black and white**
- **Draft quality**

- **Row and column headings**
- **Comments**: (None)

**Print**

- **Page order**: Down, then over

**Page Setup**

Don't want to print the entire sheet? Click the collapse dialog box to the right of the **Print area** window, and select the area you want to print with your mouse first.

**Printing Your Spreadsheet**

When you are satisfied with the way your spreadsheet will look when printed, you just need to click on the **File** pull-down menu, then **Print**:

![Print dialog box](image)

Choose proper printer by clicking on down arrow here.

Once the printer has been selected, you need only click on the **Print** button on the Standard Toolbar the next time you want to print.
DISPLAYING FORMULAS

If things did not turn out quite the way you expected, you may find it easier to check all of your formulas within the spreadsheet with the formulas (instead of the formula results) displayed in the cells. To do this, simply hold down the Ctrl key, and while holding it down, press the key with the tilde on it (~), which is usually the key to the immediate left of the numeral 1 on top of the keyboard. All cell values will be displayed, which you can then print, if you want to. You may find it necessary to re-adjust your column widths before printing this out, however, since displaying the formulas may take up more space than the original cell contents:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Carolyn</td>
<td>9</td>
<td>10</td>
<td>9</td>
<td>=SUM(B4:D4)</td>
<td>=E4/E$11</td>
</tr>
<tr>
<td>5</td>
<td>Cynthia</td>
<td>13</td>
<td>12</td>
<td>18</td>
<td>=SUM(B5:D5)</td>
<td>=E5/E$11</td>
</tr>
<tr>
<td>6</td>
<td>Frank</td>
<td>13</td>
<td>9</td>
<td>16</td>
<td>=SUM(B6:D6)</td>
<td>=E6/E$11</td>
</tr>
<tr>
<td>7</td>
<td>Joe</td>
<td>10</td>
<td>7</td>
<td>13</td>
<td>=SUM(B7:D7)</td>
<td>=E7/E$11</td>
</tr>
<tr>
<td>8</td>
<td>Sally</td>
<td>14</td>
<td>8</td>
<td>20</td>
<td>=SUM(B8:D8)</td>
<td>=E8/E$11</td>
</tr>
<tr>
<td>9</td>
<td>Sam</td>
<td>9</td>
<td>11</td>
<td>12</td>
<td>=SUM(B9:D9)</td>
<td>=E9/E$11</td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Totals</td>
<td>=SUM(B3:B9)</td>
<td>=SUM(C3:C9)</td>
<td>=SUM(D3:D9)</td>
<td>=SUM(E3:E9)</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

An alternative to the above is to click the Tools pull-down menu, then click Options. You will see the following dialog box, where you can turn on or off various features, including showing the formulas:

Be sure View tab is selected to turn formulas on or off. Check the other tabs, however, for a variety of other features.

Check this box to display formulas. Uncheck it to revert to regular view.
HELP FACILITY

Like all other products in the *Office 2000* suite, *Excel* offers several ways to get help. The most direct is to click on the **Help** button in the Standard Toolbar: 

This brings up the Office Assistant, where you can type keywords of questions into a box. You can also click the **Help** pull-down menu, and click **Microsoft Excel Help**. To get rid of the Office Assistant, *right-click* over it, then *left-click* **Hide**.

For more conventional help (without the Assistant), when the Office Assistant is showing click the **Options** button in the Assistant's help window, which will lead to this screen:

![Office Assistant Options](image)

Uncheck this box to get rid of the Office Assistant for good. (If you want it back, click the **Help** pull-down menu, then click **Show the Office Assistant**.)

This document was originally conceived by Margaret Kozak of Dominican University's Computer & Information Sciences Department, and updated by Ken Black, Director of Teaching and Learning Technology. May 2001.